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What’s New In This Release? 

The following table summarizes the i2 Analyst's Notebook 7 releases: 

Version Release Date 

i2 Analyst's Notebook 7.0.13 (inc. SP1) March 2008 

i2 Analyst's Notebook 7.0.11 November 2007 

i2 Analyst's Notebook 7.0.9 SR2 October 2007 

i2 Analyst's Notebook 7.0.7 July 2007 

Analyst’s Notebook 7.0.13 (inc. SP1) 

Analyst’s Notebook 7.0.13 (including SP1) resolves issues discovered since the release 
of Analyst’s Notebook 7.0.11, and includes the following new and updated features: 

Saving charts in Analyst’s Notebook Version 6 format 

It is now possible to save Version 7 charts in Analyst’s Notebook Version 6 format: this 
will make it easier to share charts in environments where, for operational reasons, there 
is a mix of Version 6 and Version 7 installations.  

The Save As command now has the option of saving charts in Version 6 format. Some 
features of Version 7 charts are not available in Version 6 and you will be warned if 
potentially significant data could be lost by saving the chart in Version 6 format. The 
warning will include a summary of the potential problems; a full report is available, thus 
enabling you to decide whether to proceed. Details of the types of data that may be lost 
are available in the Analyst’s Notebook online help. By default, Version 6 charts are 
saved in Version 6 format until changes are made that require them to be saved in 
Version 7 format. 

Displaying OLE objects 

Handling of images in charts has been enhanced. Previously, on some computers, OLE 
embedded pictures in charts were being displayed as icons rather than displaying the 
whole image. You no longer need to install any other application to display images 
correctly; however any existing OLE object servers are not overridden.  

Issues resolved in Analyst’s Notebook 7.0.13 (inc. SP1) 

The following issues have been resolved in this release: 

Analyst’s Notebook will now start correctly on Windows 2003 x64 (# 31384) 

Although Analyst’s Notebook is not officially supported on x64 operating systems, 
issues have been resolved that will allow organizations that wish to perform advanced 
testing to continue to do so. 

Toolbars no longer become unresponsive (# 31592) 

All, or individual, toolbars could freeze or become unresponsive under certain 
circumstances: this has been resolved. 
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Using combined properties to change attribute types will not cause Analyst’s 
Notebook to crash (# 31641) 

Analyst’s Notebook could close unexpectedly if a chart had two entities of different 
entity types that use the same icon and combined properties was used to change the 
entity type: this has been resolved. 

Visual Search no longer fails to search on link type “is member of” (# 31668) 

Visual Search now correctly finds matches on linked entities through the "is member 
of" palette search condition when applied to the link. 

Analyst’s Notebook 6 import specifications are now upgraded correctly (# 
31762) 

Analyst’s Notebook 6 import specifications that had entity or link properties containing 
multiple columns of information were not being upgraded correctly: this has been 
resolved. 

Running an import when the outermost chart item was a corner will no longer  
cause Analyst’s Notebook to close unexpectedly (# 31765) 

If a chart was open in Analyst’s Notebook, and the outermost chart item was a corner, 
an unhandled exception could occur on importing: this has been resolved. 

Importing hundreds of links between two entities no longer causes the import 
to fail (# 31775) 

Running an import specification where the Connection Multiplicity was set to multiple 
and there were hundreds of links between two entities could cause the import to fail 
and also cause Analyst's Notebook to close unexpectedly. Running an import 
specification that had thousands of links between two entities when the link style was 
set to Multiple could also cause the application to close unexpectedly: these issues 
have been resolved. 

Analyst’s Notebook 7.0.11 

Analyst’s Notebook 7.0.11 resolved issues discovered since the release of Analyst’s 
Notebook 7.0.9 SR2. Details of the issues resolved by Analyst’s Notebook 7.0.11 are 
listed in the Analyst’s Notebook 7 Hotfix 3 TA28. 

Analyst’s Notebook 7.0.9 SR2 

Analyst’s Notebook 7.0.9 resolved issues discovered since the release of Analyst’s 
Notebook 7.0.7. Details of the issues resolved by Analyst’s Notebook 7.0.9 are listed in 
the Analyst’s Notebook 7 Hotfix 2 TA23. 

Analyst’s Notebook 7.0.7 

The following new and updated features were included in Analyst's Notebook 7.0.7: 

Importing data 

The Importer was redesigned to make the process of importing data easier. It helps you 
to construct and visualize an import design before you import the data. An Import 
Manager lets you preview your import specifications, and you can now import Excel 
spreadsheets in addition to text files. A tutorial-style user guide accompanies the new 
Importer. 
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Note: To help identify information gaps in your data, the creation behavior of entities 
with blank identities has changed. Data with missing identity values will now 
create entities with blank identities. If these are not required they can be removed 
from the chart using analysis tools such as List Items. 

Pen-Link telephone data is no longer imported through the use of a dedicated menu 
command. If you have used the Import Phone Data command from the File menu in 
previous versions of Analyst’s Notebook, you can access the same functionality by 
selecting Import from File from the Data menu, locating your Pen-Link data file and 
selecting Pen-Link within the Define Columns page of the Import Editor. Full instructions 
for use can be found in Analyst’s Notebook Help within the topic entitled Importing Pen-
Link Data. 

Icon Shading 

Icons used by your entities can be shaded with a specific color to add more visual impact 
to your charts. For example, a car icon can be shaded silver, and a motorbike icon can be 
shaded green. 

Printing Headers and Footers 

You can print any of the chart summary properties, custom properties, and auto-
generated details in the headers and footers of all your chart pages. For example, you 
can label all your pages with the print date, a version number, the author and chart title. 
You can also choose where in the headers and footers this information is printed. 

Chart Cover Sheet 

The Cover Sheet displays chart summary information including chart custom properties 
before the chart is opened and before it is saved. This allows you to see important 
information such as the chart's classification before you decide to open it. 

List Data Records 

Data records are used as a way of storing and displaying extra information about a chart 
item provided by a data source. You can quickly view all of the data records in your chart 
using List Data Records to help you group and analyze the data records in a way similar 
to List Items. 

Filtering and Sorting in List Items, List Cards, and List Data Records 

You can sort up to three columns of data in the List analysis tools to create specific 
groupings of chart items, cards or data records. When you have identified the information 
of interest, you can filter from view the unwanted information, to help reduce the volume 
of data you are analyzing. 

Multiple Undo and Redo 

Multiple levels of undo and redo are now available to help you undo most changes you 
have previously made to your chart, or redo changes you have made which you have 
previously undone. 

Finding Items Linked to an Entity 

The Linked Items Bar lets you see all the entities that are linked to a specific entity in your 
chart. It is useful for establishing the associations for one item in large charts where the 
network of connections cannot be easily seen. You can review all the linked items in a 
list, click on them to see where they are in your chart, and follow their onward 
connections. 
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Hyperlinks 

Analyst’s Notebook recognizes all the most common hyperlink types, so you can link to 
documents on network servers and display Web sites, which may be relevant to your 
analysis. 

Chart Custom Properties 

Charts can include additional customer-specific summary information. This information 
can be viewed and modified both within Analyst's Notebook and from Windows Explorer. 
For example, an organization may require a chart’s classification level or the name of the 
operation to be stored with the chart. 

Mix of Languages within Charts and Chart Items 

Languages using different alphabets may be used within the same charts and chart 
items. For example, a label for a single chart item can contain English, Greek, Russian 
and Arabic text. 

New Chart Icons 

New icons have been added in response to customer requests. The new icons include 
updated and more comprehensive military icons as well as general additions to the 
standard icons. 

A summary of the new features can be found by clicking the What’s New button on the 
Tip of the Day dialog. 

i2 Online iLink  

A compatible version of Online iLink is included with this release. Online iLink allows 
users to visualize information from supported data sources in Analyst’s Notebook charts. 
For more information regarding Online iLink refer to the i2 Online iLink Release Notes 
available from your Start menu under:  

i2 ► i2 Analyst’s Notebook 7 ► Documentation ► i2 Online 7 iLink Release Notes 

Notes for existing Analyst’s Notebook 6 users 

Saving charts in Version 6 format 

Charts can now be opened in Version 7, modified, and subsequently saved in Version 6 
format. See Saving charts in Analyst’s Notebook Version 6 format on page 2 for more 
details. 

Updating customized templates 

This version of Analyst’s Notebook provides you with the latest templates, import 
specifications and report specifications. Product enhancements, such as the addition of 
new icons, are made available through these files and, where appropriate, you should 
make sure you are using the latest versions. 

If you have customized Analyst’s Notebook 6 templates and wish to utilize them within 
Analyst’s Notebook 7 the templates must be merged. Open the appropriate Analyst’s 
Notebook 7 template and follow the instructions in the Merging Templates topic. 

Compatible companion products 

You may have licensed one or more Analyst’s Notebook companion products. 
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Older versions of companion products work exclusively with older versions of Analyst’s 
Notebook. In order to use these products with Analyst’s Notebook 7, you must install 
these updated versions. 

• i2 iBase 5 

• i2 iBridge 3 

• i2 TextChart 3 

• i2 ChartExplorer 2 

• i2 PatternTracer 2 

Versioning Information 

Analyst's Notebook 7.0.13 contains new features and additional issues resolved since the 
release of Analyst's Notebook 7.0.11. The following product versions should be upgraded 
to 7.0.13: 

 
Product Version affected 
i2 Analyst’s Notebook 7.0.7 
i2 Analyst’s Notebook 7.0.9 SR2 
i2 Analyst’s Notebook 7.0.11  English language version only 

System Requirements 

These are the recommended system hardware requirements to run only Analyst’s 
Notebook: 

Requirement 

1.4 GHz processor computer 

512 MB RAM 

500 MB free disk space for installation, plus space to store chart data (if not already 
installed, add: 280 MB for .NET 2 Framework) 

XGA capable graphics card (1024 x 768 high color (16 bit)) and color monitor  

Mouse or Trackball 

USB Port or Parallel Printer Port (for local dongle) 
CD-ROM drive or network access (for installation) 

For better performance and for running a combination of i2 products, a higher 
specification is recommended: 

Requirement 

At least 2 GHz processor computer 

At least 1 GB RAM 

At least 1 GB free disk space for installation plus space to store chart data (if not already 
installed, add: 280 MB for .NET Framework). Total disk space requirements depend on 
number of i2 products to be installed. 

SXGA capable graphics card (1280 x1024 high color (16 bit)) and color monitor 
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These are the supported operating systems for Analyst’s Notebook: 

Operating System 

Windows Vista Business/Enterprise/Ultimate x86 

Windows XP Professional x86 SP 2 

Windows 2000 Professional SP 4 

Windows 2000 Server/Advanced Server SP 4 with Terminal Services optionally with 
Citrix MetaFrame Presentation Server 4.0 

Windows Server 2003 and Windows Server 2003 R2 Standard/Enterprise x86 SP1 with 
Terminal Services optionally with Citrix MetaFrame Presentation Server 4.0 

This release of Analyst’s Notebook will run in 32 bit compatibility mode (WoW64) on 64 
bit versions of the above operating systems. At this time, i2 does not formally support 
running in these environments but plans to do so in a future release.

Analyst’s Notebook is supported on Western Europe & USA, Central Europe, Baltic, 
Cyrillic, Turkic, Arabic, Japanese, Traditional Chinese and Simplified Chinese, regional 
versions of the supported operating systems. 

The initial release will only be supported on English versions of Windows Vista. Support 
on English versions is limited and there are known issues that we plan to fix in later 
releases. Support on Western Europe & USA, Central Europe, Baltic, Cyrillic, Turkic and 
Arabic regional versions of Windows Vista will be available when we release a fully 
supported version of our products on Vista. Analyst’s Notebook is not User Access 
Control (UAC) compliant.   

Analyst’s Notebook requires that Microsoft .NET Framework 2.0 is present on the 
installation system. A compatible version of Microsoft .NET Framework is included on the 
CD. 

The printed documentation provided with Analyst’s Notebook is also available 
electronically in Adobe PDF format. In order to display this documentation, a PDF viewer 
must be present on the installation system. Adobe Reader version 8 is included on the 
CD. 

Analyst’s Notebook interoperates with applications in the following versions of Microsoft 
Office: 

• Office 2003 (all editions) 

• Office 2007 (all editions) 

Analyst’s Notebook can work with documents created by the following Office versions 

• Office 2000 (all editions) 

• Office XP (all editions) 

• Office 2003 (all editions) 

• Office 2007 (all editions) 

Issue No. 1.0  i2 Analyst's Notebook 7 7 



Authorization Information 

Analyst’s Notebook is a licensed product and requires a dongle containing a valid permit 
in order to run. 

Updated NetHASP License Manager 

If you use a NetHASP authorization solution (a red network dongle), you are required to 
use License Manager 8.20, or higher. 

Version 8.31 can be found on the product CD in the following location: 

CD Drive:\Dongle\HASP Server\Windows 

Further details regarding the installation of the License Manager are available in the 
NetHASP License Manager Guide. 

Note: Novell Netware is no longer supported as a platform for running NetHASP 
authorization. License Manager must run on a Windows platform. The version on 
the CD is not fully supported on Windows Vista. 

NetHASP timeout 

A timeout value is set for each client workstation so that the NetHASP server releases 
permits after 60 minutes of application inactivity. This prevents permits from being held 
indefinitely if they are not released at the end of a session. 

Notes for existing users 

Analyst’s Notebook 7 uses the same dongle permits as Analyst’s Notebook 6. Therefore 
existing users do not require a replacement dongle.  

NetHASP authorization 

If you use a NetHASP authorization solution and you have specific configuration 
information in NetHASP.ini then you should copy the NetHASP.ini configuration file 
from your Analyst’s Notebook 6 folder to the new i2 Analyst’s Notebook 7 
folder. 

On a typical Analyst’s Notebook 6 installation the configuration file is located at: 

C:\Program Files\Analyst's Notebook 6 

For a typical Analyst’s Notebook 7 installation, this file should be copied to: 

C:\Program Files\i2 Analyst's Notebook 7 
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Documentation  

Manuals 

There is a new i2 Analyst’s Notebook 7 User Guide: Importing for this release. The other 
manuals in the documentation have also been updated. All manuals are supplied in PDF 
format and are typically installed to: 

C:\Program Files\i2 Analyst's Notebook 7\Resources\language\ 
Documentation\User Guides. 

The user guides can also be accessed from your Start menu under: 

i2 ► i2 Analyst's Notebook 7 ► Documentation

The following manuals exist for Analyst’s Notebook: 

Document Title Part Number 

i2 Analyst’s Notebook 7 Quick Start Guide 1313 

i2 Analyst’s Notebook 7 User Guide: Creating Charts 1310 

i2 Analyst’s Notebook 7 User Guide: Importing 1311 

i2 Analyst’s Notebook 7 User Guide: Customizing & Analyzing 1312 

i2 user guides are example based and are designed to help users learn how to use the 
software. You should install the example material so that users can work through the 
examples. The example material is described below. 

Note: Please make sure that at least one electronic copy (PDF) of the product 
documentation is installed in a central location and is accessible to all users.  

The i2 Products Packaging and Deployment Guide is supplied on the CD in PDF format. 
The guide location is: 

CD:\i2 Analyst's Notebook 7\Deployment\Documentation 

Example material 

Selections of example charts are provided with Analyst’s Notebook. On a typical 
installation these examples are located at:  

C:\Documents and Settings\User Name\Local Settings\Application 
Data\i2\i2 Analyst's Notebook 7\language\Example Charts 

The example charts can also be accessed from your Start menu under: 

My Documents ► i2 ► i2 Analyst's Notebook 7 ► Example Charts 

In some examples in the user guides, the first thing the user is asked to do is open an 
existing chart. The example material is typically installed to: 

C:\Documents and Settings\User Name\Local Settings\Application 
Data\i2\i2 Analyst's Notebook 7\language\User Guide Example 
Material 

The example material can also be accessed from your Start menu under: 

My Documents ► i2 ► i2 Analyst's Notebook 7 ► User Guide Example Material
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Online help 

Comprehensive online help is available from within Analyst’s Notebook that provides 
reference information for all of the product’s functionality. 

White Papers 

The following white papers are available from your supplier. 

White Paper Title Part Number 

What’s New in i2 Analyst’s Notebook 7 1394 

Upgrading to i2 Analyst’s Notebook 7 1393 

i2 Analyst’s Notebook 7 Product Overview 1395 

Utilities 

The following utilities are available within Analyst’s Notebook and are installed in the 
Utils folder beneath the installation folder for Analyst’s Notebook: 

• Reset Toolbars.exe 

This application resets toolbar settings to the Analyst’s Notebook defaults. 

• SeriesImport.exe 

This command line application allows you to automate running one or many import 
specifications into your charts. 

Documentation describing how to use these utilities is available in the online help.  

Installation 
Before installing Analyst's Notebook, please check that your system meets all the system 
requirements. Please refer to the Systems Requirements section of these release notes. 

Notes for existing i2 users 

If i2 PatternTracer version 1.1 is on the installation computer, it will be automatically 
updated to version 1.1.5. This is to ensure that PatternTracer will function with the 
updated NetHASP authorization mechanism. This updated version of PatternTracer is not 
compatible with Analyst’s Notebook 7. PatternTracer 2 is now available; this is a 
compatible companion product for Analyst’s Notebook 7. 

If your organization has a change control policy for installed versions of i2 products, you 
should contact i2 Technical Support for more information on this subject. 

Windows Terminal Services 

If you are installing using Terminal Services then you must install using the Add or 
Remove Programs facility of Control Panel. To complete the installation Analyst’s 
Notebook users must log off and log on again.  

If you are deploying on Citrix you must refer to the i2 Products Packaging and 
Deployment Guide for information on how to publish the application and end user profile 
information. 
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Using Setup.exe 

To install Analyst’s Notebook: 

1. Close all applications that you might have open. 

2. If present remove any USB Authorization Device (Dongle). 

3. Insert the product CD into your computer’s CD drive. 

The installation will start automatically. If it does not start automatically, you need to 
browse to the CD and run Setup.exe in the i2 Analyst's Notebook 7 folder. 

4. Follow the prompts to complete the installation. 

The following shortcuts will be installed: 

i2 ► i2 Analyst’s Notebook 7 Start Analyst's Notebook. 
i2 ► i2 Analyst’s Notebook 7 ► Documentation Access the product documentation in 

PDF format. 

Note: Administrator privileges are required in order to install Analyst’s Notebook. 

Automated and silent installs 

To install an i2 product with all of its default settings, but with no need for intervention 
from the user, you can perform a "silent install" like this: 

Setup.exe /s /v/quiet 

In terms of the installed product, issuing this command has the same effect as double-
clicking the file and giving the simplest possible (affirmative) response to every question. 
However, the user sees no feedback at all about the installation process until the product 
shortcut appears in the Start menu. 

To provide the user with a little more information about what is happening to their 
computer (but still using default options, and allowing no intervention), you can use 
/passive instead of /quiet: 

Setup.exe /s /v/passive 

For more details refer to the i2 Products Packaging and Deployment Guide. 

Using Windows Installer (MSI) 

This version of Analyst’s Notebook is available as an MSI Package. For more details on 
installing using Windows Installer please refer to the i2 Products Packaging and 
Deployment Guide. 

Third party software 

Installing Analyst’s Notebook installs third party software. For full details of the third party 
software installed and how to prevent its installation, refer to the i2 Products Packaging 
and Deployment Guide. 
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Microsoft .NET Framework language packs 

In order to have Microsoft .NET Framework information dialogs displayed in a local 
language you need to install a corresponding language pack. You can download 
Microsoft .NET Framework version 2 language packs from the Microsoft Web site: 

http://www.microsoft.com/downloads/details.aspx?FamilyID=39c8b63b-f64b-4b68-a774-
b64ed0c32ae7&DisplayLang=en. 

Language specific files 

The user locale setting controls the installation of language specific files and folders. For 
more details refer to the i2 Products Packaging and Deployment Guide. 

Customizing installed files 

For information on customizing installed files please refer to the i2 Products Packaging 
and Deployment Guide. 

Spelling dictionaries 

Analyst’s Notebook provides a spelling check facility based on the contents of an installed 
dictionary. Only one dictionary may be installed at a time. The following dictionaries are 
available: 

American French-Canadian 

British German 

Dutch Italian 

Finnish Norwegian 

French Spanish 

Swedish Danish 

To install an alternative dictionary for use by the spelling checker select a different 
Spelling Checker language feature in the installer’s Custom Setup. This can also be 
carried out after installation, by clicking Change against the Analyst’s Notebook entry in 
Add or Remove Programs. 

Modification and Uninstallation  

Installing Analyst’s Notebook adds an entry to your Add or Remove Programs. 

You can use this entry to: 

• Change features of Analyst’s Notebook such as the Spelling Dictionary and Online 
iLink  

• Uninstall Analyst’s Notebook 
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Known Limitations 

Printing 

The Analyst’s Notebook icon set incorporates transparency so that icons may be used on 
areas of the chart where the background is not white, for example in filled event frames or 
on top of background items. The printing of these icons is complex and on some older 
computer and printer combinations there may be problems. In particular, the icons may 
print incorrectly or printing may be very slow. To overcome these difficulties, two printing 
options are provided, as described below. These options can be found in the Advanced 
Printer Setup dialog, which is accessed using the Advanced button on either the Printer 
Setup or Print dialogs. 

• Always Simulate Transparent Icons 

This option uses an alternative, simpler means of printing transparent icons. Try this 
option if the icons do not appear correctly. Printing will be slower using this option. 

• Use Basic Icon Drawing 

This option uses a very basic means of printing icons. Try this option if the icons do 
not appear correctly or if printing is too slow. Printing will not include any transparency 
using this option and therefore icons will always have a white square surround. 

Displaying OLE objects 

Analyst’s Notebook is now capable of displaying .bmp, .jpeg and .gif OLE objects 
without the requirement for any third party OLE server. However, the following limitations 
still apply: 

• If your operating system has an application that has taken ownership of .bmp, 
.jpeg or .gif files, and it is not a valid OLE server, the drag and drop from 
Windows Explorer may return the error message “Unexpected file format.” If you 
encounter this issue, try inserting the image from the Insert OLE Object ► 
Picture menu.  

• If an unrecognized file type is dragged onto the chart surface and the 
“Unexpected file format.” warning is received, subsequent drag and drop 
operations to the chart surface from Windows Explorer may fail. If you encounter 
this issue try inserting the object from the Insert OLE Object ► Picture menu.  

Save As Version 6 not available if attribute class names are written in non-western characters  

Attribute classes whose names are not written using western characters can cause an 
issue when using the Save As Version 6 feature. Some Analyst’s Notebook 7 charts that 
contain attribute classes whose names contain unavailable characters, will not be able to 
be saved as Version 6 charts, if the Save As is performed on a computer with a different 
language operating system. For example a Chinese chart, that contained attribute class 
names written in Chinese characters, may not be able to be saved as a Version 6 
compatible chart on an English operating system. 

Hidden and background chart items lose their chart position after pasting (# 13538) 

Reported: 6.0.7 

Pasting a chart containing hidden or background chart items can cause these chart items 
to lose their original chart positions in the new chart. 
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Embedding a chart using OLE may generate an application error (# 28061) 

Reported: 6.0.55 

After embedding a chart in another application using OLE, an Analyst’s Notebook 
application error may be generated. However the chart is successfully embedded in the 
application and the error message should be ignored. 

Find Matching Entities may report an error if all links are removed from the chart (# 28069) 

Reported: 6.0.55 

When Find Matching Entities has identified a large number of matching items that cannot 
be displayed at the same time in the chart fragment, it displays only those matches for the 
selected chart items. If the Find Matching Entities selection is changed in this limited 
display mode and all the links on the main chart have been removed then Find Matching 
Entities reports an error. 

Chart Save updates the date/time created when it should only update the time modified 
(# 28259) 

Reported 6.0.55 

When you update and save a chart, the created date/time in Microsoft Windows Explorer 
is changed as well as the modified date/time. 

The items sizing behavior can be unpredictable (# 27943) 

Reported 7.0.0 

When an item contains lots of text with line breaks, the sizing of the event can be 
unpredictable. 

Analyst’s Notebook crashes when searching using Label Matching and ignoring certain 
characters (# 29642) 

Reported 7.0.0 

When running on Microsoft Windows 2000 SP4 Analyst's Notebook can crash when 
searching using Label Matching and ignoring some numerical characters. 

Analyst’s Notebook can fail to start if a large number of Internet Explorer windows are open 
(# 29714) 

Reported 7.0.0 

If a large number of Internet Explorer windows are open when launching Analyst’s 
Notebook, the application can fail to start. If Analyst’s Notebook is already running, 
opening a large number of Internet Explorer windows can cause it to close.  

Performing a save operation changes the file permissions on the chart (# 28568) 

Reported 7.0.0 

Saving a chart under certain circumstances can change the Windows security settings on 
the file. If you open a chart, then change the permissions so Full Control is denied, make 
a modification to the chart, then save the changes the file permissions are reset to Allow. 
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Analyst’s Notebook 6 charts do not insert into Microsoft Office applications as expected after 
upgrading to Analyst’s Notebook 7 (# 29822) 

Reported 7.0.0 

If you only have Analyst’s Notebook 7 installed and insert a Version 6 chart into a 
Microsoft Office application the chart will always display as an icon rather than a chart 
even if Display as icon is turned off. 

If you open the chart in Analyst’s Notebook 7 and save it in the updated format it will 
insert into a Microsoft Office application and display correctly as a chart.  

Drag and drop from Analyst’s Notebook as a bitmap into Microsoft Word does not function 
correctly (# 29987) 

Reported 7.0.1 

The issue occurs if the Cut and Copy to Clipboard options are set to Picture as Bitmap 
only. When dragging chart items from Analyst’s Notebook and dropping into Microsoft 
Word 2003, the expected image is not created. 

A workaround for this issue is to use Copy and Paste functionality to copy chart items 
into a Word Document. 

Microsoft Installer runs a repair when copying a chart as an OLE Object (# IR 998) 

Under certain circumstances an Installer repair can be triggered. The chart must have the 
Background Color set to transparent and the Cut and Copy To Clipboard has Chart 
as OLE Object selected. In Microsoft Word the document has a background color set. 
When the chart is copied and pasted into the Word document the installer repair is 
triggered. An update to Microsoft Office 2003 rectifies this issue. More information is 
available from http://support.microsoft.com/kb/907417/  

The Highlighter tool behavior is abnormal when copying and pasting between charts (# 30430) 

Reported 7.0.4 

When highlighting links the color and strength changes during while the highlighting 
process is active. If the chart items are then selected, copied and pasted into a new chart 
the links default properties are set to the highlighted properties. 

Dragging an Online iLink visualization into Analyst’s Notebook 7 fails if ChartReader 6 has 
been installed (# 31059) 

Reported 7.0.7 

Dragging an Online iLink visualization into Analyst’s Notebook 7 fails if ChartReader 
6.0.13 or earlier with Online Chart Saver has been installed. 

This issue cannot be resolved. In order to save Online iLink visualizations continue to use 
Analyst’s Notebook 6 or ChartReader 6. Once the visualizations have been saved in 
Version 6 they can be opened in Version 7. 

An error can occur when a user logs on using Terminal Services (# IR 1628) 

Reported 7.0.7 

When a user connects to the server via Terminal Services an error "Only administrators 
have permission to add, remove, or configure server software during a Terminal Services 
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remote session. If you want to install or configure software on the server, contact your 
network administrator" can occur. 

To resolve this issue the administrator must run Analyst’s Notebook on the server. 

Microsoft Vista Known Limitations 

Analyst’s Notebook can be installed and operates on Windows Vista. However not all 
aspects of product behavior may be as effective as on Windows 2000 and XP. i2 is 
committed to updating its product suite to fully support Vista in the near future. 

Known issues with Analyst’s Notebook operating on Windows Vista are as follows: 

Some third party components are not fully supported on Vista (#31000) 

Reported: 7.0.0 

Not all of the third party components that are installed and used by Analyst’s Notebook 
are claimed to be supported on Vista by their suppliers. As they become available i2 will 
include supported versions of third party applications in future releases. Unless stated in 
the known issues below the third party components have not shown to cause issues. 

What’s This? Help is not natively supported in Windows Vista (#30396) 

Reported: 7.0.0 

Analyst’s Notebook uses Windows Help (WinHlp32.exe) to deliver What’s This? Help 
functionality. Microsoft is not shipping Windows Help with Vista. You can download a 
compatible version of Windows Help from Microsoft Download site 
http://go.microsoft.com/fwlink/?LinkID=82148  

More information can be found on Microsoft Knowledge Base 
http://support.microsoft.com/kb/917607

i2 files can not be indexed and searched by Vista search mechanism (#30999) 

Reported: 7.0.0 

The files created by i2 Products can not currently be indexed and searched by the 
Windows Vista search mechanism.  

Document Properties do not work on Windows Vista (#30361) 

Reported: 7.0.0 

Some entries in the summary information are not visible on Windows Vista.  The 
'Description' and 'Origin' sections are not visible through Explorer. 

Opening multiple charts from Windows Explorer fails and causes errors (# 29956) 

Reported 7.0.0 

In some instances attempting to open multiple Analyst’s Notebook charts from Windows 
Explorer results in errors. The error messages are dependant on whether Analyst’s 
Notebook was running or not. The error only occurs when attempting to open certain files. 
All charts will open individually. 
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Redraw issue when show desktop is used on Microsoft Vista (# 29271) 

Reported 7.0.0 

An error occurs if the Analyst’s Notebook window is maximized, then show desktop is 
activated twice. The Analyst’s Notebook window will maximize on the second activation, 
but all the toolbars and window areas will be black. 

Contacting i2 

Technical support is available to anyone whose organization has opted for our annual 
support program. If you have a question and cannot find a solution in the online help, you 
can send an e-mail to the i2 Technical Support team. 

• For customers in North and South America, e-mail support@i2inc.com. 

• For customers in the UK or the Rest of the World, e-mail support@i2.co.uk.  

Note: If your i2 software was purchased from one of our distributors, please contact 
your supplier for technical support. 

i2 International and i2 Inc. Professional Consulting services work with customers to 
understand specific requirements and then determine the best methods to get these 
requirements met through custom development, on-site training, or alignment with the 
right system integrator or product vendor.  

For further information, contact your i2 supplier, or visit the i2 Web site at: 
www.i2group.com.
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